Vector NTI Advance® 11.5.2 Release Notes and Installation/Licensing Guide

Catalog Numbers  12605050, 12605099, and 12605103
Publication Number MAN0007615
Revision 1.0
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Notes for Version 11.5.2</td>
<td>5</td>
</tr>
<tr>
<td>Fixes to Known Issues</td>
<td>5</td>
</tr>
<tr>
<td>Release Notes for Version 11.5.1</td>
<td>6</td>
</tr>
<tr>
<td>Changes to the GeneArt® Assembly Tool</td>
<td>6</td>
</tr>
<tr>
<td>Fixes to Known Issues</td>
<td>7</td>
</tr>
<tr>
<td>Release Notes for Version 11.5</td>
<td>7</td>
</tr>
<tr>
<td>What’s New and Improved in Version 11.5</td>
<td>7</td>
</tr>
<tr>
<td>Fixes to Known Issues</td>
<td>8</td>
</tr>
<tr>
<td>Open Issues in Version 11.5</td>
<td>10</td>
</tr>
<tr>
<td>System Settings and Requirements</td>
<td>11</td>
</tr>
<tr>
<td>Minimum System Requirements</td>
<td>11</td>
</tr>
<tr>
<td>Administrator Account</td>
<td>11</td>
</tr>
<tr>
<td>DLS Customers</td>
<td>11</td>
</tr>
<tr>
<td>User Account Control (UAC) Settings</td>
<td>12</td>
</tr>
<tr>
<td>Downloading the Software or Installing from a CD</td>
<td>13</td>
</tr>
<tr>
<td>Downloading and Installing from the Website</td>
<td>13</td>
</tr>
<tr>
<td>Installing from a CD</td>
<td>13</td>
</tr>
<tr>
<td>Default File Locations</td>
<td>13</td>
</tr>
<tr>
<td>Upgrading from Previous Versions</td>
<td>14</td>
</tr>
<tr>
<td>IMPORTANT: Local Database Backup</td>
<td>14</td>
</tr>
<tr>
<td>Binary Conversion of the Local Database</td>
<td>14</td>
</tr>
<tr>
<td>Uninstalling Previous Versions</td>
<td>14</td>
</tr>
<tr>
<td>New Invitrogen Vectors</td>
<td>14</td>
</tr>
<tr>
<td>Upgrade Steps</td>
<td>14</td>
</tr>
<tr>
<td>Shared Database Compatibility with Previous Versions</td>
<td>14</td>
</tr>
<tr>
<td>New Installations</td>
<td>15</td>
</tr>
<tr>
<td>Creating a Local Vector NTI Database</td>
<td>15</td>
</tr>
<tr>
<td>Setting Up Multiple Users on the Same Computer</td>
<td>16</td>
</tr>
<tr>
<td>How to Install from the Command Line</td>
<td>17</td>
</tr>
<tr>
<td>Modifying, Repairing or Removing an Existing Installation</td>
<td>18</td>
</tr>
<tr>
<td>Updating an Existing Installation</td>
<td>18</td>
</tr>
<tr>
<td>Licensing Vector NTI Advance® Software</td>
<td>19</td>
</tr>
<tr>
<td>Types of Licenses</td>
<td>19</td>
</tr>
<tr>
<td>License Number</td>
<td>19</td>
</tr>
<tr>
<td>License Manager</td>
<td>19</td>
</tr>
<tr>
<td>Initiating Vector NTI Advance® Licensing</td>
<td>20</td>
</tr>
<tr>
<td>License Indicator</td>
<td>21</td>
</tr>
<tr>
<td>Transferring Vector NTI Advance® Software to a New Computer or New Operating System</td>
<td>22</td>
</tr>
<tr>
<td>License and Hardware ID</td>
<td>22</td>
</tr>
<tr>
<td>Backing Up the Local Database and Settings</td>
<td>22</td>
</tr>
<tr>
<td>Restoring the Database and Vector NTI Advance® Settings</td>
<td>23</td>
</tr>
<tr>
<td>Appendix A. Technical Support</td>
<td>24</td>
</tr>
</tbody>
</table>
Release Notes for Version 11.5.2

Fixes to Known Issues

Issue: Subfolders created within the database disappear when the Tables folder (in the Vector NTI Advance® database folder on the C: drive) is renamed.
Resolution: During startup Vector NTI Advance® will create a new Tables folder, and the user will be prompted to copy the data from the renamed Tables folder to the newly created Tables folder.

Issue: Unable to open contig projects created using old Vector NTI® versions.
Resolution: Version 11.5.2 allows you to open old contig files.

Issue: Changes in font style of annotations were not saved to the database.
Resolution: Font style changes are now saved.

Issue: The Standard Arrangement button was disabled when circular molecules were opened in the Molecule Viewer.
Resolution: This button is now enabled for circular molecules.

Issue: Software could not connect to target DAS servers (NCBI, UCSF, local DAS server) if the URLs had changed.
Resolution: The URLs have been fixed, and users can now modify a URL if it changes.

Issue: GenomeBench data was deleted during a software upgrade.
Resolution: When a user creates a new database, the software will save the old GenomeBench database in a newly created VNTI Database\GenomBenchDBBackup folder.

Resolution: The menu now appears.

Issue: Warning message did not display when a temporary license was about to expire.
Resolution: Message now displays.

Issue: FASTA files with dashes in the file name could not be read.
Resolution: These files can now be read.

Issue: ContigExpress could not handle more than 14 assemblies.
Resolution: This has been fixed, and now there is no upper limit on ContigExpress assemblies.

Issue: The User Field Definition in the Columns Field Manager of Database Explorer no longer has predefined values.
Resolution: Predefined values are now available.

Issue: There was no way to add values to the User Field Definition in the Columns Field Manager of the Database Explorer.
Resolution: An Add button is now available.

Issue: In the Database Explorer, typing the first letter of a molecule name does not automatically jump to the first molecule in the list starting with that letter.
Resolution: This feature now works.

Issue: The PCR using existing oligos command returns a “Primers not found” error after the user selects “Amplify selection.”
Resolution: The software now locates the correct primers and amplifies correctly.
**Issue:** GenomeBench is unable to save or create new sequences.  
**Resolution:** This defect has been fixed and the tool functions normally.

**Issue:** Attempting to create a new Remote Data Source returns an error.  
**Resolution:** This tool now functions normally.

**Issue:** Database backup was not working correctly.  
**Resolution:** A new automatic database backup system has been implemented. The user can now set the number of days between automatic backups.

**Issue:** The option to enter an author name that will be displayed when files are created or modified is automatically overwritten with the name “Demo User.”  
**Resolution:** This defect has been fixed and the author name displays normally.

**Issue:** The software could not export oligos from the database into a spreadsheet.  
**Resolution:** Export to a CSV file is now enabled.

**Issue:** Exporting to a .gb file from GenomeBench results in an error message, and the exported file cannot be opened.  
**Resolution:** The file now exports and opens correctly.

**Issue:** The installer incorrectly reported that the v11cc.msi file does not match.  
**Resolution:** The installer now identifies the file correctly.

**Issue:** System did not automatically create backup directories if user deleted the backup folder.  
**Resolution:** Backup directories are now automatically created.

**Issue:** The GeneArt® Tool created duplicate features when a parent feature was edited and the descendants recalculated.  
**Resolution:** Editing a parent feature now correctly propagates to descendants.

**Issue:** Molecules emailed directly from the software were missing a .gb extension in the file name.  
**Resolution:** The .gb extension is now included.

**Issue:** Renaming a molecule in Database Explorer did not display the new name.  
**Resolution:** The new name now correctly displays.

**Issue:** PCR primers were not correctly saved during GeneArt® assembly.  
**Resolution:** PCR primers are now saved correctly.

**Issue:** The Camera command was not functioning correctly in the Phylogenetic Tree window.  
**Resolution:** Camera now functions correctly.

**Issue:** When User Access Control (UAC) was on, double-clicking on the installer did not install the software correctly.  
**Resolution:** Double-clicking the installer now works when UAC is on.

---

**Release Notes for Version 11.5.1**

**Changes to the GeneArt® Assembly Tool**

- Internal homology analysis is now performed on fragments for High Order Assembly using NCBI BLAST technology, provided by the National Center for Biotechnology Information.
• Primers designed by the GeneArt® Tool now include adjacent homology blocks for co-amplified PCR fragments.

• The coordinates of PCR primers in circular assemblies have been revised based on their location in the circular plasmid.

• The sequence editing function within the GeneArt® Assembly Tool has been removed. The user must edit each fragment sequence prior to adding it to the GeneArt® tool.

• There is no upper limit on the size of the individual fragments that can be assembled using the tool, provided the length of the total assembly is no greater than 13 kb for Seamless Cloning and 110 kb for High Order Assembly. For fragments longer than 20 kb, we recommend using the long PCR primer design tool in Vector NTI and a highly processive PCR enzyme.

• In High Order Assembly, the software will compare fragment ends to internal fragment sequences. If an end has more than 25 bp of homology to an internal sequence, assembly will be disallowed.

• In High Order Assembly, the software will compare the internal homology of fragments. If there is 50 bp or more of internal homology, the assembly will be disallowed.

• If existing end homology between two fragments extends beyond 1000 bp in High Order Assembly or 100 bp in Seamless Cloning, assembly will be disallowed.

Fixes to Known Issues
• The fit-to-window button in the Molecule Viewer now functions correctly.
• The spelling of the menu item “Manage Report Template” has been corrected.

Release Notes for Version 11.5
Vector NTI Advance® 11.5 is freely available to all licensed version 11.0 and 11.1 users, and to users of older versions of the software with a current Advanced Support contract.

What’s New and Improved in Version 11.5

Applied Biosystems ABI 3500 file format support
An update to the existing .ab1 chromatogram file format has been released by Applied Biosystems to support the new 3500 capillary electrophoresis (CE) sequencing instrument. Vector NTI Advance® 11.5 allows users to import 3500-generated .ab1 files into the CEX Project Window by selecting Project > Add Fragments > From AB1 File… or by drag-and-drop into the CEX Project Window.

Vector NTI Advance® 11.5 displays the 3500-specific tag information in the Chromatogram Viewer, and allows user to specify what tag information to display via the View Options setting.

Primer template alignment display and report
Users can now view the base-by-base alignment between a primer and template in the Molecule Viewer by right-clicking on a motif. In addition, the Vector NTI Report Generator (File > Molecule Operations Report > Comprehensive Report…) now includes displaying the base-by-base motif alignment either in plain text or following GenBank format.

Update to the NCBI query format
Starting in June 2010, any query made to NCBI’s eUtilities web tools is required to provide a tool name and a pre-registered email address. This email address will be used by NCBI should the user violate any usage policy of eUtilities. In PubMed Entrez Search and Query Application, Vector NTI Advance® 11.5 allows user to specify an email address prior to making any NCBI query. Optionally, the user can set a preferred email address for all queries to eUtilities.
**Improved workflow for querying TaqMan® Gene Expression assays online**

Vector NTI Advance® 11.5 enables searching for pre-designed TaqMan® Gene Expression Assays or designing custom TaqMan® Assays.

In searching pre-designed assays, you can now manage almost the entire workflow from within Vector NTI. You can start by searching for the assay, add items from the search results into local shopping cart, and submit your order to Applied Biosystems website.

From Database Explorer or Molecule Viewer, you can select either the entire sequence or part of the sequence and invoke the Custom Assay Design Tool. You can manage your local list of sequences and submit that all at once to the Applied Biosystems website.

**Improved local database performance**

An improvement was made in version 11.5 to the local database performance. Now you can manage up to 32,000 DNA/RNA/protein molecules, 100,000 oligonucleotides, 10,000 enzymes, 100,000 citation records, 100,000 BLAST results, 100,000 Analysis Results, and 5,000 Gel Marker records in the local database without experiencing greatly slower performance.

**Synthetic biology workflows—GeneArt® Assembly**

GeneArt® Assembly is a novel cloning technology developed by Life Technologies that is not dependent upon restriction enzymes. Instead, overlapping oligonucleotide sequences are used to guide the assembly of segments of DNA sequences. Vector NTI Advance® 11.5 introduces a GeneArt® Assembly workflow that enables you to specify the fragments of sequence that you want to assemble, which are then automatically assembled using the GeneArt® Assembly algorithm. The resultant construct, PCR primers, and stitching oligonucleotides can be saved into your local database for future use.

**Synthetic biology workflows—BioBrick® Assembly**

BioBrick® is an important standard in synthetic biology that supports the basic creation and manipulation of small functional pieces of DNA. Vector NTI Advance® 11.5 allows you to create and assemble molecules using BioBrick® assembly standards.

BioBrick® is a registered trademark of the BioBricks Foundation, a not-for-profit organization that facilitates the development and responsible use of technologies based on BioBrick® standard DNA parts that encode basic biological functions. For more information, visit [http://bbf.openwetware.org](http://bbf.openwetware.org).

**Fixes to Known Issues**

**Issue:** Design and construct buttons were disabled by default in the Molecule Viewer, and these buttons were not always enabled correctly.

**Resolution:** V11.5 fixes the issue to enable the buttons correctly.

**Issue:** Molecule Viewer crashes when pasting sequences with features at the first coordinate of another molecule.

**Resolution:** V11.5 fixes the crashing issue and allows pasting sequences with features at the first coordinate.

**Issue:** ORF Finder was generating incorrect results when searching for ORF using the settings of “Incomplete”, “Stop” and “Nested.”

**Resolution:** V11.5 corrected the ORF finding results.

**Issue:** Could not open a .gb molecule file in Molecule Viewer using the Open dialog box.

**Resolution:** User can open a .gb file in Molecule Viewer using Open dialog box.

**Issue:** In PubMed-Entrez application, right-clicking “Open/Save to DB” option on the search results did not save the molecules into local database.

**Resolution:** V11.5 allows saving of multiple search results into local database.
**Issue:** In Molecule Viewer, when performing the action of Analysis > Restriction Analysis > Find Common Non-cutting Enzymes, the progress bar would sometimes freeze.

**Resolution:** Progress bar now displays correctly without freezing the application.

**Issue:** In Query Application, when performing the PubMed Entrez Search against the Genome or PopSet databases, clicking on the URL of the search results will open an invalid webpage.

**Resolution:** V11.5 updated the broken URL.

**Issue:** In Database Explorer, performing Database Backup / Database Restore / Database Cleanup on large database would freeze the application.

**Resolution:** Progress bar now displays correctly when performing these operations without freezing the application.

**Issue:** In Database Explorer, when performing a Search operation on Name field, the wildcard character ‘?’ behaved like the wildcard ‘*’.

**Resolution:** Wildcard character ‘?’ now represents a single character search.

**Issue:** In AlignX, AlignX Blocks and Molecule Viewer, when prompting the user to save the changes and exit the application, if the user used the keyboard to select No, changes would still be saved.

**Resolution:** V11.5 fixes this issue and correctly discards changes if the user selects No.

**Issue:** When launching AlignX from Molecule Viewer’s Alignment PCR function, the Text Pane in AlignX would only display the molecule names without details.

**Resolution:** V11.5 now displays the full molecule details in the Text Pane.

**Issue:** After performing analysis from Analysis Monitor, attempt to save the analysis results into any subbase would save into the Main folder instead.

**Resolution:** V11.5 saves the analysis results into subbases correctly.

**Issue:** In Molecule Viewer, when doing Gateway Cloning > Create an Entry Clone > Amplify selection to use in BP reaction, the sequence was displayed in the 3’ – 5’ direction for antisense primers.

**Resolution:** V11.5 displays the sequence in 5’ – 3’ direction.

**Issue:** In the menu of Molecule Viewer and Database Explorer, the URL for Bioinformatics services @NCBI and Bioinformatics services @ExPASy were not valid. The Vector NTI User Community should also be removed.

**Resolution:** Updated the URL for Bioinformatics services @NCBI and Bioinformatics services @ExPASy, and removed the link to Vector NTI User Community.

**Issue:** The email and URL in the License Manager was pointing to invitrogen.com domain.

**Resolution:** Updated the email and URL to point to lifetech.com domain.

**Issue:** In BLAST Search application, the list of database in the blastn and blastp programs was not updated.

**Resolution:** Updated the list of database in blastn and blastp programs.

**Issue:** The databases for PROSITE, REBASE and BLOCKS that shipped with Vector NTI were not the latest versions.

**Resolution:** Latest versions of these databases are now shipped with version 11.5.

**Issue:** Uninstalling Vector NTI Advance 11 was allowed to proceed even if QuickStart Page application is open.

**Resolution:** V11.5 will not uninstall if QuickStart Page is open.

**Issue:** No shortcut icons were created after Vector NTI software was installed successfully.

**Resolution:** Shortcut to Molecule Viewer and QuickStart Page are created on desktop.
**Issue:** The AM folder is created under the same folder as the local database. This folder contains program executables and it should be created under the software’s installation folder instead.

**Resolution:** V11.5 creates the AM folder under the Vector NTI Advance® installation folder.

---

### Open Issues in Version 11.5

#### Unable to paste dot matrix plot from AlignX

**Issue:** The Camera button is not functioning for the dot matrix plot. Plot cannot be pasted into external tools.

**Workaround:** Use the print screen function in Windows®, copy the desktop, and paste the image into the external tools.

#### View Motif Alignment menu item is not disabled on Sequencing Primers or Hybridization Probes Found In A Molecule

**Issue:** In Molecule Viewer, the View Motif Alignment menu item can be used to bring up the Primer Template Alignment dialog on motifs found in a molecule. However, when user performs PCR Primer > Sequencing Primers or PCR Primer > Hybridization Probes, user can still invoke this option when right clicking the results in the Text Pane. This freezes the Molecule Viewer.

**Workaround:** No workaround exists. User should not click this option.

#### Unable to create new color scheme by element ID in 3D Molecule Viewer

**Issue:** If the user tries to create a new color scheme by element ID from View > Color Scheme in the 3D Molecule Viewer, the application will terminate.

**Workaround:** No workaround exists. User can create new color scheme by other options.

#### Attempt to invoke Custom Gene Expression Assay Design menu item freezes ContigExpress®

**Issue:** In ContigExpress®, if user invokes Analyses > TaqMan > Custom Gene Expression Assay Design option, ContigExpress® freezes.

**Workaround:** User can invoke the Custom Gene Expression Assay Design from Molecule Viewer.

#### “Fit to window” does not fit the molecule to the Graphic Pane in Molecule Viewer

**Issue:** In Molecule Viewer, clicking on the Fit to Window button on the toolbar will not change the molecule display size.

**Workaround:** User can invoke the Zoom In or Zoom Out options to change the molecule display.

#### Confusing error message in GeneArt® tool

**Issue:** In GeneArt® tool, if the user tries to perform assembly with only 1 fragment in the GeneArt® fragment list, there is a confusing error message that the fragment does not share end terminal homology with the next fragment. The actual problem is that GeneArt® needs at least 2 fragments to assemble.

**Workaround:** User should have at least 2 fragments before performing GeneArt® assembly.

#### The new name in Database Explorer is not updated automatically after renaming an object

**Issue:** In Database Explorer, after the user renames an object, the new name is not automatically updated.

**Workaround:** User can click View > Refresh, or click F5, to refresh the Database Explorer to see the new name.

#### The Orientation column in GeneArt® tool is always defaulted to Direct

**Issue:** In GeneArt® tool, the Orientation column is always showing Direct, despite that the user specifies the Strand to be Complementary when invoking GeneArt® from Molecule Viewer.

**Workaround:** User should manually check and change the Orientation column in GeneArt® tool before performing assembly.
GeneArt® tool does not allow adding features from fragments longer than 10,000 kbps

Issue: The GeneArt® tool does not allow adding any fragments that are longer than 10,000 kbps. If a feature is embedded in a fragment that is longer than 10,000 kbps, user cannot add this fragment to GeneArt®.

Workaround: User can extract the feature and save it into another molecule, and add this new molecule into GeneArt®.

New molecules created are not available for selection in GeneArt® without restarting the GeneArt® tool

Issue: When the GeneArt® tool is open, then user saves new molecules into the database, these new molecules will not appear in the Add Fragment dialog of the GeneArt® tool.

Workaround: User needs to close the GeneArt® tool, then open it again, to see the new molecules.

System Settings and Requirements

Minimum System Requirements

- Microsoft Windows®:
  - Windows® XP (Professional) SP3
  - Windows Vista® (Business) SP2
  - Windows® 7
- Macintosh®:
  - Mac OS® X running Windows® under Parallels® Desktop 5 or Boot Camp
- 50 GB HD space
- 512 Mb RAM
- Single processor
- Microsoft Installer Version 3
- Screen Resolution : 1024 × 768 or Higher

Note: Vector NTI Advance® is only supported on single processor machines. The software is not designed to run on multi-processor machines; such configurations cannot be guaranteed to operate successfully.

Administrator Account

You must be logged in as an Administrator under Windows® to install the software.

DLS Customers

This document does not address Dynamic Licensing of Vector NTI Advance® or DLS installation. Customers with a DLS License should first install and license the DLS software before installing Vector NTI Advance®.

For information on DLS installation and dynamic licensing of Vector NTI Advance®, see the DLS 3.0 Installation and Licensing Guide, available by following the “Get a License” link on www.invitrogen.com/VectorNTI.
User Account Control (UAC) Settings

You may have to turn off User Account Control (UAC) to install Vector NTI Advance® on Windows Vista® and Windows® 7.

**Important** Turn UAC back on after installation.

**Turning off User Account Control—Windows Vista®:**

1. Go to Control Panel > User Accounts > Turn User Account Control On or Off and uncheck the checkbox.

![User Account Control settings](image)

2. Click on OK and restart your computer when prompted.

**Turning off User Account Control—Windows® 7:**

1. Go to Start > Control Panel > User Accounts > Change User Account Control Settings and in the dialog box move the slider to Never Notify.

![User Account Control settings](image)

2. Click on OK and restart your computer when prompted.
Downloading the Software or Installing from a CD
This section describes the basic installation process, either from a CD or by downloading the installer from the Invitrogen website. For specific instructions on upgrading a previous installation or installing the software for the first time, see the following pages.

Note You must be logged in as an Administrator under Windows® to install the software.

Important If you have a previous version of this software installed on your computer, we strongly recommend that you back up your local Vector NTI database before proceeding.

Downloading and Installing from the Website
To download Vector NTI Advance® from the Invitrogen website, go to www.invitrogen.com/VectorNTI and follow the instructions for downloading the most recent version of the software.

When the download is complete, depending on your browser settings, you may be prompted to run the installer. Otherwise, navigate to the download location and double-click on the installation file (Vector NTI Advance 11.5.exe) to begin installation.

After installation, you must open License Manager to license your Vector NTI Advance® software (see Licensing Vector NTI Advance®, page 19).

Installing from a CD
To install Vector NTI Advance® from a CD, insert the disc into the CD drive. If Auto Run has been configured on your computer, the CD browser will open automatically. Otherwise, open the CD directory on your computer and double-click on setup.exe to begin running the installer.

After installation, you must open License Manager to license your Vector NTI Advance® software (see Licensing Vector NTI Advance®, page 19).

Default File Locations
The default file locations for a new installation are C:\Program Files\Invitrogen\Vector NTI Advance 11 (program files) and C:\VNTI Database (local database files).
Upgrading from Previous Versions

IMPORTANT: Local Database Backup

If you have a previous version of this software installed on your computer, we strongly recommend that you back up your local Vector NTI database (containing vectors, molecules, enzymes, citations, BLAST search results, etc.) before proceeding.

By default, the installer will not overwrite your existing local database; however, a database backup is recommended as a precaution.

Binary Conversion of the Local Database

When installing Vector NTI Advance®, you will be prompted to convert your local database to run in binary mode. This change will enhance database performance, but otherwise is invisible to the user.

The new local database format is not compatible with previous versions of Vector NTI. If you are concerned about back-compatibility, you can choose to not convert the database; the old database format will work with Vector NTI Advance®.

Uninstalling Previous Versions

During the installation process, you will be prompted to uninstall any previous version of Vector NTI. This will not uninstall your existing local Vector NTI database. However, as a precaution, we strongly recommend that you first perform a Vector NTI Database Backup before removing the previous version.

New Invitrogen Vectors

If you upgrade to Vector NTI Advance® from a previous version and do not overwrite your existing local database, the new Invitrogen vectors included with this release will not be installed in your database. To obtain these vectors, you can drag and drop the archive with the file name [DBINIT.MA4] from the installation CD into your default database folder (C:\VNTI Database\).

If you choose to overwrite your existing database when you upgrade, the above entries will be part of your Vector NTI Advance® database.

Upgrade Steps

You must be logged in as an Administrator to install the software.

1. Back up your existing local Vector NTI database. Follow the database backup instructions beginning on page 22.

2. Insert the CD or start the installation program to begin installation.

3. If the Install Wizard detects a previous version of Vector NTI and provides the option to uninstall it, we recommend that you select the Uninstall option.

   If you have Vector NTI Advance® 10.3.0/10.3.1, please uninstall manually prior to installing Vector NTI Advance®.

Shared Database Compatibility with Previous Versions

Vector NTI Advance® is compatible with shared databases created using Vector NTI 7, 8, 9.x, and 10.x. Shared databases created using earlier versions of Vector NTI (v.5.5 or lower) have not been tested with Vector NTI Advance® and cannot be guaranteed compatible.
New Installations

Creating a Local Vector NTI Database
For new installations, a local Vector NTI database is created during installation. This database initially contains a set of standard vectors and other molecules from Invitrogen, and it is also the default location for saving new molecules, enzymes, citations, BLAST search results, etc.

The default location for this database is in the root directory of your hard drive (e.g., C:\VNTI Database). You will be prompted to change this location during installation. Typically, the local database is installed on the same computer as the Vector NTI program files; however it may be installed on a network as described below.

Local Database Installed on a Network
You can install and use a local Vector NTI database on a network drive under two scenarios:

If your organization has implemented Microsoft Roaming User Profiles, you can access the database from any computer other than your own. These criteria must be met:

- The computer must have Vector NTI installed and licensed.
- You must log in as yourself.
- The local database must be installed on a mapped network drive.

If you do not have a Microsoft Roaming User Profile, you can store your local database on a network drive. Each time, however, that you try to access the database on a computer other than your own, these criteria must be met:

- The computer must have Vector NTI installed and licensed.
- You must re-point Vector NTI to the database on the network.
Setting Up Multiple Users on the Same Computer

You can run Vector NTI from different user accounts on the same computer. With this type of installation, a single local database can be shared among users or a separate database can be created for each user.

An Administrator account is required to install the software, but more restricted accounts (e.g., Restricted User, Standard User) can run the software.

Creating the Primary Installation

From an Administrator account, install Vector NTI on the system and ensure that Windows® is set up to allow access for each user account to the installed software. (See Windows® documentation for information about setting up multiple user accounts.)

If the primary local database is to be accessed by multiple users, it must be placed in an unrestricted root directory (e.g., C:\...).

A single license number can be used by all the accounts on the same computer, but each account must enter the license number separately. The Administrator will need to provide that license number to each user.

1. After the primary installation is complete, select Start > Programs > Invitrogen > Vector NTI Advance 11 > License Manager.
2. Proceed through the licensing steps as described in the licensing section of this installation guide (see page 19).
3. Following primary installation and licensing by the Administrator, log on to each user account, open Vector NTI, and enter the same license information in the application as before. For information about creating separate databases for each user, see the next section.

Creating Separate User Databases

1. Following the primary installation by the Administrator, log on as a user. Select Start > Programs > Invitrogen > Vector NTI Advance 11 > Vector NTI Explorer to launch Vector NTI Explorer.
2. In Explorer, select Database > Select Local Database from the menu. This launches the Choose Local Database Directory dialog box where you can create a new database (or direct Vector NTI to another existing database).
3. Select the location for the local database and click the Make New Folder button. Specify the folder name for the new database (e.g., VNTI Database User 1) and press the OK button. The new path/folder appears in the Choose Local Database Directory dialog box.
4. Press the OK button. You will be prompted to restart Vector NTI, and upon restart you will be prompted to finish creating the new database.
## How to Install from the Command Line

The following Windows® installer commands can be used to perform a command line installation of Vector NTI Advance®.

<table>
<thead>
<tr>
<th>Type</th>
<th>Command</th>
</tr>
</thead>
</table>
| **Installation Commands** | **msiexec.exe /i <file_name.msi> [/qn | /qb] [/l*v <log_filename>]** [EXECDIR="<executable_path>"], [INSTALLDIR="<db_path>"], [DLSURL="<dls_path>"]. The elements in the above statement, [EXECDIR="<executable_path>"], [INSTALLDIR="<db_path>"], and [DLSURL="<dls_path>"], allows you to specify the directories for the Vector NTI program files, database files and URL to the DLS server (if you are using a dynamic license), respectively. Examples for the three elements are as follows:

EXECDIR="C:\Program Files\Invitrogen\Vector NTI Advance 11"

INSTALLDIR="C:\VNTI Database"

DLSURL=http://serverName_or_IPaddress)/scripts/vntidls.cgi

/i – install /qn - fully silent installation /qb - basic UI mode (progress dialog + errors dialog) /l*v - generate comprehensive log file (may be useful for tracking user installation problems) |
| **Uninstall Commands**     | **msiexec.exe /x <file_name.msi> [/qn | /qb] [/l*v <log_filename>]** /X – Remove |

**Additional Commands**

IWANTDEINSTALL = "Yes" – forces deinstallation of the previous VNTI version

DBUPGRADE = "Upgrade" – upgrades previous database, rather than creating new database

MIGRATIONDIR = "<target folder>" – specifies the folder that is automatically inserted as the target folder in migration

LICENCE = "<license number>" – allows you to specify the license number, initializing the license scheme during installation

INCLUDEWC = "Yes" – forces deployment of Web Connectivity tools. (By default, these tools are not copied to the user’s computer.)

ORDER = "None" or "Web" or "B2B" – select primer ordering mechanism

*Note* In command line installation, the DLSURL is entered automatically in the License Manager of the user currently logged on during installation (usually the system administrator). All other users of multi-user machines who log in after installation must type the DLSURL manually into the Dynamic License Settings tab of the License Manager and then click the Set dynamic license for all applications button. For this reason, it is for the system administrator to distribute the DLS URL to all participating users before their first login.
Modifying, Repairing or Removing an Existing Installation

To modify, repair, or remove an existing installation of Vector NTI:

1. Go to Control Panel > Add/Remove Programs > Vector NTI Advance 11.
2. Select Change or Remove, and follow the steps on the screen.

   **Note** The Remove option does not delete the local Vector NTI database or any of its files from the hard drive. By default, the database is located in the root directory of the hard drive (e.g., C:\VNTI Database). You can either manually delete the database directory or keep it if you are re-installing the software and want to preserve the database.

Updating an Existing Installation

There may be periodic updates and bug fixes to Vector NTI Advance®. These can be downloaded from the Invitrogen website and installed as described in Downloading the Software or Installing from a CD (see page 13).
Licensing Vector NTI Advance® Software

Once you have installed Vector NTI Advance®, you will need to license the application to use it.

Types of Licenses

To satisfy the needs of users in different industrial, scientific or educational environments, Invitrogen has designed three types of Vector NTI licenses, as well as a Demo Mode option. These are all administered through the License Manager.

Static License: Purchased by one user for installation on one computer.

Corporate Static License: Static license that is used throughout a corporate organization.

Term License: Introduced with Version 11, Static Licenses are also available as 1-Year and 3-Year licenses that expire after a fixed period of time.

Dynamic License (DLS): A license that is installed on a server and issued by that server to client computers running Vector NTI Advance® software. DLS licenses are shared by a specified number of users or “seats,” with the number of users at any one time being limited to the number of “licenses” specified in the contract.

Trial License: Allotted to a potential purchaser of Vector NTI Advance® software for a specified number of days, during which the user can review and use the software within certain limits.

Demo Mode: When unlicensed, Vector NTI Advance® applications operate in Demo Mode for the purpose of demonstrating the basic features of the software. Some functionality is disabled in Demo Mode.

License Number

To license Vector NTI Advance®, you need a new License Number. If you have no connection to the internet, you also need a new Registration Key.

The License Number is provided in the letter accompanying your CD ROM and/or manual.

The Registration Key is provided by Invitrogen based on your License number and Hardware ID.

License Manager

License Manager consolidates the administration of static, trial, and dynamic licenses into one window. In this window, there is a tab for each license type.

To launch License Manager, choose Start > Programs > Invitrogen > Vector NTI Advance 11 > License Manager or click Help > License in any Vector NTI Advance® application, or from QuickStart Page by clicking on License Manager under Licensing and Support.

Contact Us Tab

This tab, opened by default, summarizes your Vector NTI Advance® software licensing agreement. Additionally, it provides information for upgrading your Vector NTI Advance® application license and for contacting Invitrogen.

User Information Tab

Enter your personal information on this tab. Once entered on this tab, when you click your license choice on the Applications tab, your entries are automatically entered on the license application.
Applications Tab

This tab summarizes the type of license currently in effect for each Vector NTI Advance® application, as well as for Vector Xpression and Vector PathBlazer, which are not included in the Vector NTI package. If you have Vector NTI Advance® software with a current license, the contract number displays in a cell to the right of the corresponding application. For applications for which there is no current license, a drop-down menu displays in the cell to the right of the corresponding application.

If you have any module or application running before you set a new license, you need to close and restart that application to apply new license to it.

Initiating Vector NTI Advance® Licensing

For a new installation or an update of a previously unlicensed installation, License Manager opens in Demo mode for all applications.

For Static, Dynamic, and Trial licenses, if you are not licensing the entire software package using the same type of license, click in the license-type box of the application for which you wish to specify a license. Click the down-arrow to extend the drop-down menu and select the appropriate license type. (Demo mode is the default selection.)

If your active license type varies for different applications, this dialog box may have a combination of rows with drop-down menus and rows displaying contract numbers (see figure at the previous page).

Click the button at the bottom of the tab for the license type you want to register. Each option is described in the following sections.

Static License

To register a Static License:

1. In the License Manager at the bottom of the Applications tab, click the Static button.
2. Enter your name, organization, phone number and email address in the appropriate fields. This sets the user information in Vector NTI Advance®. (If you entered your personal information on the Personal tab, it should appear automatically when you open this dialog box.)
3. In the License # field, enter the Vector NTI Advance® static license number provided in the email you received from Invitrogen. The hardware ID is pre-loaded in its text box.
4. Personal Static License: You must have an internet connection for this type of static license. Click the Apply button. The license is submitted via the internet and a registration key is returned and applied automatically.
Corporate Static License: No internet connection is needed nor is a registration key required. The License Manager on your client computer validates the corporate license number; if it is valid, then your software is registered.

If registration of your personal static license fails because of a problem with the internet connection, contact Invitrogen Technical Support and provide them with your computer’s hardware ID and your license number. Once you receive the registration key, enter the key in the Key text box of the Static License dialog box and click Apply. If the Key matches your license number and computer hardware ID, the license is registered.

To unregister a Static License: If you decide to remove Vector NTI from your computer, you must unregister the license BEFORE the software is uninstalled. To do so, type “unregister” in License# field, and press the Apply button. An internet connection is required.

Trial License
To configure a Trial License for Vector NTI Advance®:
1. In License Manager, at the bottom of the Applications tab, click the Trial button. This opens the Trial License dialog box.
2. As described in the dialog box, you must generate an e-mail and include your name, the name of your organization, phone number, and email address.

Dynamic License from a DLS Server
Technically, a Dynamic License is not a “license” mode, but registers permission to work in a shared DLS environment in license mode.

To configure a Dynamic License for Vector NTI Advance®, see the Installation and Licensing Guide for Vector DLS 3.0 available on the support page of the Invitrogen web site.

License Indicator
When you open any Vector NTI application, the type of license is indicated by a symbol in the lower right corner of the application window:

Static license: Green unblinking checkmark
Trial or Dynamic license: Green blinking checkmark
Demo mode (no license): Red blinking checkmark
Transferring Vector NTI Advance® Software to a New Computer or New Operating System

License and Hardware ID
Hardware IDs and registered license numbers are closely linked in Vector NTI. Changes to the operating system will result in the change of Hardware ID, and consequently revoke the existing license. A hardware ID is unique to a computer.

If the software is to be moved to a different computer, you must unregister the license before the software is uninstalled from the current computer. To do so, type “unregister” in License# field, and press the Apply button. An internet connection is required.

On the destination computer, install the software, and apply the existing license. If the operating system is to be upgraded, perform the unregister step as above before the upgrade.

Backing Up the Local Database and Settings
Before converting to a new operating system or a new computer, back up your local database and settings described below:

Backing Up the Local Database
To backup the Vector NTI Advance® database:

1. Create a new folder on a network drive or Zip drive, etc. that can be accessed from the new computer or from the old computer after the operating system upgrade is completed.

2. On the old system, open the VNTI Database Explorer and choose Database > Database Backup...

   Close all Vector NTI applications (including the main Vector NTI window, for versions 6.0 and higher) except Database Explorer when doing this.

3. Select the destination for the backup in the folder that you created for the backup. The backup will contain all molecules from the Vector NTI Advance® database, including those that were created by the user. Custom settings are NOT saved during database backup, however. To save custom settings, see the next section.

Backing Up Custom Settings
The following files contain user-customized settings and custom-created tools in Vector NTI. They are located in the main Vector NTI folder in Program Files on your hard drive (e.g., C:\Program Files\Invitrogen\Vector NTI Advance 11). To save them, copy these files to a safe, separate location during installation, and then copy them into to the same relative location on the new system.

<table>
<thead>
<tr>
<th>File Name (PC)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gelprof.ini</td>
<td>Contains customized settings for the gel analysis feature of Vector NTI Advance® Software</td>
</tr>
<tr>
<td>Molprof.ini</td>
<td>Contains customized settings for DNA/RNA molecules</td>
</tr>
<tr>
<td>Proprof.ini</td>
<td>Contains customized settings for protein molecules</td>
</tr>
</tbody>
</table>
Backing Up the Tools Subfolder

The Tools subfolder contains customized settings and html templates for any modified or created tools. It is located in the main Vector NTI folder in Program Files on your hard drive (e.g., C:\Program Files\Invitrogen\Vector NTI Advance 11\Tools).

To save these settings, copy this folder to a safe, separate location during installation, and then copy it into the same relative location on the new system.

Restoring the Database and Vector NTI Advance® Settings

Restoring the Vector NTI Database and User Profiles

To restore a Vector NTI Advance® database and user settings on a new system, perform the following steps.

CAUTION: The Database Restore command overwrites your existing database with the backup database.

1. After backing up the database(s) and saving other appropriate files, install Vector NTI on the new system or proceed with the OS update on the old system and then re-install Vector NTI.

2. Register the new Vector NTI installation in License Manager using the new static license number or configure the dynamic license.

3. Once the software is licensed and in full functional mode, restore the Vector NTI database by choosing Database > Database Restore in the Database Explorer. In the Restore Database dialog box, open the Vector NTI backup folder you created and click OK. This restores the objects from the backup file into the Vector NTI database.

   Close all Vector NTI applications except Database Explorer when you are restoring a database.

4. To restore custom Vector NTI settings, copy the custom settings and the Tools folder (see above) into the appropriate location in the new Vector NTI Advance® installation.
Appendix A. Technical Support

Free technical support for Vector NTI Advance® is available exclusively through the web. For more information, check out the Software Support section at www.invitrogen.com/VectorNTI.

To obtain personalized technical support by telephone or email, you must have an annual support contract. Users may purchase an Advanced Support Contract by contacting Invitrogen at bioinfosales@lifetech.com.

For paid support, use the following contacts:

**North America**
Phone: 800-955-6288
E-mail: bioinfosupport@lifetech.com

**Europe, Middle East, Africa, Asian Pacific**
Email: bioinfosupport@lifetech.com
Appendix B. Reinstallation Policy

Effective December 15, 2008, depending on the status of the Advanced Support Contract you may or may not have with us, the service coverage is different.

1. If you have a current Advanced Support contract with Invitrogen, this service is free of charge.

2. For versions 10 and 11, if you do not have current Advanced Support contract, Invitrogen grants a one-time only service for the number of computers registered per your original purchase order. For example, if you purchased license(s) for 10 computers, you receive one-time free reinstallation for up to 10 computers. After that, no more free reinstallations will be granted.

3. For versions 9 and older, regardless of the type of licensing (i.e., Static, Dynamic, Network), we do not provide this free service. As a standard industry practice, we are only supporting current version and previous one version.

Note You may unregister a license by yourself using License Manager (see page 22). There is no limitation on the number of unregistrations.

To request Reinstallation Service, please visit our website and submit out a Reinstallation Request Form, available on the web at:


A valid license number and hardware ID is required.
Appendix C. Vector NTI® Software and Support Product License Agreement

This is a legal agreement between you, the person or entity receiving software products and/or software support (“Licensee”), and Life Technologies Corporation, having offices at 5791 Van Allen Way, Carlsbad California 92008 USA (“Licensor”). This agreement is part of a package that includes one or more software products and certain electronic and/or written materials. This agreement covers your licensing of such software and/or purchase of support.

You must agree to the terms in this Software and Support Product License Agreement (“SPLA”) in order to access the software and/or receive support.

BY CLICKING YOUR ACCEPTANCE OF THIS SPLA, OR BY INSTALLING OR USING THE SOFTWARE (defined below) OR ANY OTHER COMPONENT OF THE PACKAGE, YOU ACKNOWLEDGE THAT YOU HAVE READ ALL OF THE TERMS AND CONDITIONS OF THIS SPLA, UNDERSTAND THEM, AND AGREE TO BE LEGALLY BOUND BY THEM. If you do not agree to the terms of this SPLA, you may not install or use the Software, and may return it to Licensor for a refund or product credit. In addition to the restrictions imposed under this SPLA, any other usage restrictions contained in the Order (defined below), Software installation instructions or release notes, and Support policies (defined below) shall apply to your use of the Software and receipt of Support.

As used in this SPLA: “Authorized Users” means, collectively, the personnel authorized by you to use the Software for your benefit, provided you have both purchased a License (as defined below) and paid the corresponding license fees. Unless otherwise expressly allowed by this SPLA, Authorized Users may include only your employees and agents having a need to know, and Authorized Users may not be entities or persons in the business of licensing or otherwise providing products or services competitive with the Software. “Designated Site” means your facilities or offices located at the postal address provided to Licensor for your billing and invoicing purposes, unless otherwise indicated in a license key provided to you. “Software” means the software product(s) accompanying this SPLA and the content therein; including the associated user manuals, user documentation and application program interfaces, and License Numbers and Registration Key(s) provided, and any patches, updates, upgrades, improvements, enhancements, fixes and revised versions of any of the foregoing that may be provided to you from time to time, and any combination of the foregoing. “Order” means that part of a written or electronic document that identifies (1) the Software to be licensed to you, (2) the Authorized Scope (defined below), (3) any Support purchases, (4) the purchase price, and (5) location for delivery, and in each case as expressly agreed upon by Licensor. “Affiliate” means any entity Controlling, Controlled by, or under common Control with the referenced entity, where the term “Control” means the possession, direct or indirect, of the power to direct or cause the direction of the management and policies of an entity, whether through the ownership of voting securities, by contract, or otherwise.

1. YOUR PAYMENT OBLIGATIONS. You agree to pay all amounts due or incurred by you, including any late payment fees, as are specified in this SPLA, in the Order, and/or any associated invoice. All fees and amounts due Licensor are exclusive of all taxes, duties shipping fees, and similar amounts. If any authority imposes a duty, tax or similar amount (other than taxes based on Licensor’s income), you agree to pay, or to promptly reimburse Licensor for, all such amounts. Unless otherwise indicated, all invoices are payable thirty (30) days from the date of invoice. Overdue amounts are subject to a late payment charge, at the lower rate of (i) one and one-half percent (1.5%) per month, or (ii) the maximum rate under applicable law. You agree to promptly pay or reimburse Licensor for all costs and expenses, including all reasonable attorneys’ fees, related to breach of your obligations under this SPLA and/or Licensor’s enforcement of this SPLA. All shipments by Licensor or its designee are FCA point of shipment (Incoterms 2000).

2. ACCEPTANCE. Except with respect to Software provided under a Trial or Demonstration License (each defined below), you will be deemed to have accepted the Software unless you provide written notice of rejection within ten (10) days after receipt of the Software or the corresponding License Number and Registration Key, if any ( whichever event occurs first). Any such notice must state the reason for rejection, and you may only reject the Software if it fails to materially comply with its accompanying documentation. If you reject the Software, Licensor’s sole obligation and liability, and your sole and exclusive remedy, shall be for Licensor to use commercially reasonable efforts to deliver to you a replacement for the nonconforming Software, and if Licensor is not able to deliver a replacement for the Software, then Licensor will refund any license fees paid by you for the Software, and in the event of any such refund, the SPLA shall terminate. Software provided under a Trial or Demonstration license shall be deemed accepted upon receipt.

3. GRANT OF SOFTWARE LICENSE. Subject to the terms and conditions of this SPLA, Licensor grants to you a non-exclusive, non-transferable license (“License”) for Authorized Users to use the Software and Support for your internal operations and internal data processing purposes within and up to the Authorized Scope described on the Order, and for which you have paid the applicable license and support fees and have registered the Software for use. Except as otherwise provided below, this SPLA and the License granted hereunder shall be effective until terminated in accordance with Section 8 below. The term “Authorized Scope” means the following, and any other capacity, term/duration, or use restrictions indicated by Licensor on the license granted to you:
If you have purchased a “**Static License**”, then, for each such license purchased you may install and operate the Software on a single designated computer (“workstation”) located at the Designated Site. You may not network the Software for use at any other geographic location. Use of the Software is limited to the single workstation designated for each Static License purchased. You may also purchase one (1) year or three (3) year Academic Licenses, which, notwithstanding anything to the contrary contained herein, shall expire one (1) or three (3) years, respectively, from the date you receive the Academic License.

The Dynamic License configuration is comprised of a defined number of concurrent use licenses (Dynamic Licenses) shared among a defined number of workstations (“**User Access Seats**”). If you have purchased a “**Dynamic License**”, you may install the Software on the number of individual workstations located at the Designated Site for which you have purchased Seat Licenses; these Seats then share the number of Dynamic Licenses purchased. For example, if you purchased five (5) Dynamic Licenses and ten (10) Seat Licenses, you may enable the Software for concurrent use on up to five (5) of the ten (10) individual Seats simultaneously. You may not enable concurrent operation of the Software beyond the scope of the Dynamic and Seat Licenses purchased. You may not network the Software for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Termination or expiration of support shall immediately terminate the Dynamic and Seat Licenses and this SPLA.

The Network License configuration is comprised of a defined number of concurrent use licenses (Network Licenses) shared among an UNLIMITED number of workstations (“**User Access Seats**”). If you have purchased a “**Network License**”, you may install the Software on all individual workstations located at the Designated Site for which you have purchased a Network License configuration; these Seats then share the number of Network Licenses purchased. For example, if you purchased eight (8) Network Licenses, you may enable the Software for concurrent use on up to eight (8) individual workstations simultaneously. You may not enable concurrent operation of the Software beyond the scope of the Network Licenses purchased. You may not network the Software for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Termination or expiration of support shall immediately terminate the Network Licenses and this SPLA.

If you have purchased a “**Site License**”, then you may install and operate the Software on an UNLIMITED number of individual workstations located at the Designated Site. You may not network the Software for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Termination or expiration of support shall immediately terminate the Site License and this SPLA.

If you have purchased a “**Corporate**” license, then you may install and operate the Software on an UNLIMITED number of individual workstations located at the Designated Site. A Corporate License allows you to use a single License Number to license all workstations. Furthermore, a Corporate License does not require each individual workstation to access Licensor’s License Registration Server through the Internet. Corporate License Numbers are Licensor’s Confidential Information. You may not network the Software for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Termination or expiration of support shall immediately terminate the Corporate License and this SPLA.

If you have purchased a “**Workgroup License**”, then, for each such license purchased you may install and operate the Software on a single workstation located at the Designated Site. A Workgroup License enables you to create an unlimited number of Shared Databases; different types of Workgroup Licenses allow different numbers of users to access those Shared Databases. You may not network the Software for use at any other geographic location. Use of the Software is limited to the single workstation designated for each Workgroup License purchased. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Termination or expiration of support shall immediately terminate the Workgroup License and this SPLA.

If you have purchased a “**Named User License**”, then your license applies to the LabShare® Software only. You may allow up to the number of named users for which you have purchased a Named User License to connect to the LabShare® Software. A “Named User” is defined as one individual user identified with a unique user name and password on the LabShare® Software system. Each named user may operate no more than one LabShare® session from a single individual workstation at a time. Only named users may use the LabShare® Software. The individual workstations must all be located at the Designated Site. You may not network the Software for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Termination or expiration of support shall immediately terminate the Named User Licenses and this SPLA.

Any Software provided under a “**Trial License**” is provided for your internal evaluation purposes only, pending your purchase of a commercial-use Software license and payment of the applicable license fees. You may install and operate the Software on a single designated workstation located at the Designated Site. You may not network the Software for use at any other geographic location. A Trial License may not be used for any commercial purposes. A Trial License may automatically be converted into a commercial license (e.g., with Authorized Scope converted into a Static License) upon payment of the applicable license fees to Licensor or issuance of the applicable License Number and Registration Key, if any (whichever event occurs first). Upon such conversion, this SPLA shall continue in full force and effect, subject to the restrictions applicable to the new Authorized Scope. Software provided under a Trial License is made available to you “AS IS”, AND LICENSOR MAKES NO REPRESENTATION OR WARRANTY REGARDING SUCH SOFTWARE.

Any Software provided under a “**Demonstration License**” is provided for your internal demonstration purposes only, and not for commercial or research purposes. You may not use the Software provided under a Demonstration License to operate upon data other than the data provided to you under the Demonstration License. You may not use any other software in conjunction with the Software provided under a Demonstration License to operate upon data other than the
data provided to you under the Demonstration License. Software provided under a Demonstration License is made available to you "AS IS", AND LICENSOR MAKES NO REPRESENTATION OR WARRANTY REGARDING SUCH SOFTWARE.

4. **RESTRICTIONS ON USE.** You acknowledge that you are receiving LICENSED RIGHTS only. The Software may only be used internally, by your Authorized Users, with the License Number and Registration Key (if any) provided, for your copy(ies) of the Software. If any Software is provided on separate media (e.g., a CD-ROM), you may make a single copy solely for your internal backup purposes. You shall not directly or indirectly: (i) sell, rent, lease, distribute, redistribute or transfer any of the Software or any rights in any of the Software, including without limitation through "charge back" or any other selling, reselling, distributing or redistributing within your organization of any usage capacity you have licensed, without the prior express written approval of Licensor, (ii) modify, translate, reverse engineer (except to the limited extent permitted by law), decompile, disassemble, attempt to discover the source code for, create derivative works based on, or sublicense any of the Software, (iii) use any Software for the benefit of any third parties (e.g., in an ASP, outsourcing or service bureau relationship), or in any way other than in its intended manner, (iv) remove any proprietary notice, labels, or marks on or in the Software, or (v) disable or circumvent any access control or related device, process or procedure established with respect to the Software, including the License Number and Registration Key (if any) or any other part thereof. Further, without Licensor’s prior express written consent, you may not: (i) network the Software for use at any other geographic location; (ii) enable operation of concurrent “instances” of the Software beyond the scope of the license purchased; (iii) share accounts, e.g., pool multiple users through a single account, or (iv) “multiplex” or “pool” any Software, including through use of third party software products such as those made by Citrix Systems, Inc., or use any terminal applications/emulators to enable use of the software beyond the scope of the license purchased. If the Software design permits modification, then you may only use such modifications or new software programs for your internal purposes and otherwise consistent with the License and Authorized Scope. You are responsible for all use of the Software and for compliance with this SPLA; any breach by you or any user of the Software shall be deemed to have been a breach by you. Licensor reserves all rights not expressly granted; no right or license is granted hereunder, express or implied or by way of estoppel, to any intellectual property rights other than as expressly set forth herein; and your purchase of a license to the Software does not by itself convey or imply the right to use the Software in combination with any other product(s). As between you and Licensor, Licensor retains all right, title, and interest in and to the Software, which rights include, but are not limited to, patent, copyright, moral, trademark, trade secret and all other intellectual property rights. You agree and acknowledge that you have been provided sufficient information such that you do not need to reverse engineer the Software in any way to permit other products or information to interoperate with the Software.

5. **NO SEPARATION OF COMPONENTS.** The Software is licensed as a single product. Some Licensor software products combine separately available components into a single product (e.g., a software suite product may be comprised of multiple component products). When licensed as a combination product, the component parts may not be separated for use independently of the combination product. You must first purchase a license to each component of the combination product before you may use it independently of the combination product.

6. **TEACHING LICENSES.** The Software may be licensed under a Teaching License program. Software licensed under such a program is subject to (i) the terms of a Static License as described in Section 3 and (ii) the additional restrictions in this Section 6. Software licensed under a “Teaching License” is restricted to use by students and teachers only in support of the classroom instruction of students and related class-work, such as the preparation of classroom materials, and the review and grading of exams, papers and class-related projects. Students may use the Software for class-related laboratory work and homework assignments. Use of the Software licensed under such a Teaching License program for any purposes other than as described in this Section, including for commercial or production purposes, or for non-classroom related research, is strictly prohibited.

7. **ADDITIONAL PURCHASES.** Purchase of additional or changed licenses or Authorized Scope is subject to availability and current pricing. Licensor may, from time to time, update the available Authorized Scope plans, and add or delete from available plans. To the extent you purchase an upgrade to your license by expanding the Authorized Scope under a changed or additional plan, Licensor will provide you with the additional license terms and conditions governing your use of the Software under such plans; all other terms and conditions of this SPLA shall remain in effect.

8. **TERM AND TERMINATION.** Unless otherwise agreed, the term of this SPLA shall continue until it is terminated; however, if you are receiving a Trial or Demonstration License, the term shall expire thirty (30) days following the date you receive the Software. Termination or expiration of this SPLA shall concurrently terminate all Licenses granted under this SPLA. Licensor shall not refund any amounts paid by you hereunder in the event of expiration or termination of this SPLA unless expressly provided in this SPLA. Licensor may (i) terminate an Order and the Licenses to the Software and/or Support on that Order if you fail to pay any applicable fees due under that Order within fifteen (15) days after receipt of written notice of non-payment; and/or (ii) terminate this SPLA (or any License) upon fifteen (15) days written notice if you breach this SPLA and do not cure the breach within fifteen (15) days following receipt of written notice of breach. Immediately upon any termination or expiration of this SPLA, you agree to: (a) pay all amounts owed to Licensor; (b) uninstall and cease use of the Software for which your rights have been terminated; (c) upon request, return to Licensor (or destroy) all copies of the Software and any other Confidential Information or proprietary materials in your possession for which your rights have been terminated; and (d) upon request, certify in writing your compliance with (b) and (c), above.

9. **CONFIDENTIALITY.** You agree to protect Licensor’s Confidential Information with the same degree of care used to protect your own confidential information (but in no event less than a reasonable standard of care), and not to use or disclose any portion of such Confidential Information to third parties, except as expressly authorized in this SPLA. You acknowledge that the Software, including its content, structure, organization and design constitute proprietary and valuable
trade secrets (and other intellectual property rights) of Licensor and/or its licensors. The term “Confidential Information” means, collectively, non-public information that Licensor (and its licensors) provide and reasonably consider to be of a confidential, proprietary or trade secret nature, including but not limited to (i) the Software, (ii) Software License and Support prices, (iii) Software License Numbers and Registration Keys, and (iv) confidential elements of the Software and Licensor’s (and its licensors’) technology and know-how, whether in tangible or intangible form, whether designated as confidential or not, and whether or not stored, compiled or memorialized physically, electronically, graphically, or in writing. Confidential Information does not include any information which you can demonstrate by credible evidence: (a) is, as of the time of its disclosure, or thereafter becomes part of the public domain through no fault of yours; (b) was rightfully known to you prior to the time of its disclosure, or to have been independently developed by you without use of Confidential Information; and/or (c) is subsequently learned from a third party not under a confidentiality obligation with respect to such Confidential Information. Confidential Information that is required to be disclosed by you pursuant to a duly authorized subpoena, court order, or government authority shall continue to be Confidential Information for all other purposes and you agree, prior to disclosing pursuant to a subpoena, court order, or government authority, to provide prompt written notice and assistance to Licensor prior to such disclosure, so that Licensor may seek a protective order or other appropriate remedy to protect against disclosure.

10. WARRANTY AND DISCLAIMER. Licensor warrants that (i) except with respect to Software provided under a Trial or Demonstration License (in respect of which no warranty is made, as described in Section 3), for a period of twenty (20) days from the date of acceptance of the Software as described in Section 2, the Software will, under normal use and as unmodified, substantially perform the functions described in its accompanying documentation; and (ii) Licensor will perform Support services during the Support term in a professional and workmanlike manner. No warranty is provided for uses beyond the Authorized Scope. THE FOREGOING EXPRESS WARRANTIES REPLACE AND ARE IN LIEU OF ALL OTHER WARRANTIES AND REPRESENTATIONS BY LICENSOR, WHETHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO ANY IMPLIED OR OTHER WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, NON-INFRINGEMENT OR NON-MISAPPROPRIATION OF INTELLECTUAL PROPERTY RIGHTS OF A THIRD PARTY, CUSTOM, TRADE, QUIET ENJOYMENT, ACCURACY OF INFORMATIONAL CONTENT, OR SYSTEM INTEGRATION. NO WARRANTY IS MADE THAT ANY SOFTWARE WILL OPERATE IN AN ERROR FREE, UNINTERRUPTED OR COMPLETELY SECURE MANNER, IN COMBINATION WITH THIRD PARTY HARDWARE OR SOFTWARE PRODUCTS, OR THAT ALL DEFECTS CAN BE CORRECTED. YOU ACKNOWLEDGE THAT LICENSOR HAS NO CONTROL OVER THE SPECIFIC CONDITIONS UNDER WHICH YOU USE THE SOFTWARE. ACCORDINGLY, EXCEPT FOR THE FOREGOING EXPRESS WARRANTY, LICENSOR CANNOT AND DOES NOT WARRANT THE PERFORMANCE OF THE SOFTWARE OR ANY PARTICULAR RESULTS THAT MAY BE OBTAINED BY THE USE OF THE SOFTWARE. THE SOFTWARE AND SUPPORT DO NOT REPLACE YOUR OBLIGATION TO EXERCISE YOUR INDEPENDENT JUDGMENT IN USING THE SOFTWARE. The warranties made by Licensor may be voided by abuse or misuse of the Software and/or Support.

11. EXCLUSIVE REMEDY. Licensor’s sole obligation and liability, and your sole and exclusive remedy under the warranties set forth in Section 10, shall be for Licensor to use commercially reasonable efforts to have the problem remedied, to re-perform Support services, to deliver to you a replacement for the defective Software, or to refund fees paid (in each case, as determined by Licensor and as applicable), provided that Licensor is notified in writing of all warranty problems during the applicable warranty period.

12. THIRD PARTY SOFTWARE AND DATABASES. You understand that third party products integrated into the Software or provided for use with the Software may be subject to additional terms and conditions and/or license agreements from the applicable third party vendor, which shall govern over conflicting terms of this SPLA for purposes of your relationship with the third party vendor. You agree not to use any such third party product on a stand-alone basis independent of the Software, unless you have purchased the appropriate license from the third party vendor for use of such products. NOTWITHSTANDING ANYTHING TO THE CONTRARY IN THIS AGREEMENT, ALL THIRD PARTY SOFTWARE, DATABASES AND OTHER PROGRAMS AND SOFTWARE COMPONENTS ARE PROVIDED “AS IS” WITHOUT ANY WARRANTY WHATSOEVER FROM LICENSOR. ANY DATABASES OR OTHER INFORMATION PROVIDED BY LICENSOR ARE DESIGNED TO SUPPLEMENT OTHER SOURCES OF INFORMATION, ARE NOT INTENDED TO REPLACE YOUR PROFESSIONAL DISCRETION AND JUDGMENT AND LICENSOR MAKES NO REPRESENTATIONS OR WARRANTIES REGARDING SUCH DATABASES OR INFORMATION, THEIR ACCURACY, COMPLETENESS OR OTHERWISE. Licensor agrees, upon request and as Licensor’s sole liability and obligation, and for your convenience only, to have passed through to you (to the extent it may reasonably do so) any warranties and indemnifications provided by the applicable third party vendor of any third party products provided to you. To the extent any problem or liability arises from a third party product, you agree to seek recourse solely from the applicable third party vendor and not Licensor.

13. LICENSOR INDEMNIFICATION. Subject to the limitations set forth herein, Licensor agrees to defend you against any claims, actions, suits and proceedings brought against you by unaffiliated third parties arising from or related to a claim that the Software (other than any third party or open source components or elements) infringes upon such third party’s copyrights, and Licensor agrees to pay all damages that a court finally awards to such third party, and all associated settlement amounts agreed to by Licensor in writing; provided that, Licensor receives from you (i) prompt written notice of the claim; (ii) all necessary assistance, information and authority necessary for Licensor to defend the claim and perform Licensor’s obligations under this Section; and (iii) sole control of the defense of such claim and all associated settlement negotiations. If such a claim is made or appears likely to be made, you agree to permit Licensor to enable you to continue to use the affected Software, or to have the Software modified to make it non-infringing, or to have the Software replaced with a substantially functional equivalent. If Licensor determines that none of these options is reasonably available, then Licensor may terminate this SPLA in whole or with respect to the affected Software product, and you may be entitled to a
SECTION 11), AND/OR (IV) INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, PUNITIVE, RELIANCE, OR INFRINGEMENT. Licensor will have no responsibility for (v) any use of any product after you have been notified to discontinue use because of a third party claim of infringement, (w) the alteration of the Software or the combination of the Software with third party materials, products or software, (x) use of the Software by any person or entity other than an Authorized User, (y) any misuse or unauthorized use of the Software, or (z) failure to use provided updated or modified Software to avoid a claim of infringement or misappropriation.

14. INDEMNIFICATION BY YOU. You agree to indemnify and defend Licensor, its licensors, and its affiliates, against any third party claims arising from or related to your use or misuse of the Software or any breach of the terms and conditions of this SPLA, and you agree to pay all costs, losses, damages, and attorneys’ fees that a court finally awards, and all associated settlements.

15. LIMITATION OF LIABILITY. EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAW, IN NO EVENT WILL LICENSOR’S OR ITS AFFILIATES’ TOTAL, AGGREGATE LIABILITY ARISING FROM OR RELATED TO THIS AGREEMENT, THE SOFTWARE AND/OR SUPPORT (INCLUDING FOR NEGLIGENCE, STRICT LIABILITY, BREACH OF CONTRACT, MISREPRESENTATION, AND OTHER CONTRACT OR TORT CLAIMS), EXCEED THE AMOUNT OF YOUR DIRECT DAMAGES ACTUALLY INCURRED, UP TO THE AMOUNT OF FEES PAID TO LICENSOR UNDER THIS AGREEMENT FOR THE SOFTWARE PRODUCT OR SUPPORT PRODUCT THAT IS THE SUBJECT OF THE CLAIM UNDERLYING THE DAMAGES; OR, IN THE CASE OF SOFTWARE PROVIDED UNDER A TRIAL OR DEMONSTRATION LICENSE, ONE HUNDRED DOLLARS ($100.00), WHICHER IS LESS.

16. EXCLUSION OF DAMAGES. EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAW, UNDER NO CIRCUMSTANCES SHALL LICENSOR, ITS AFFILIATES, OR ANY OF THEIR SUPPLIERS OR LICENSORS BE LIABLE HEREUNDER FOR ANY OF THE FOLLOWING: (I) THIRD PARTY CLAIMS, EXCEPT AS PROVIDED IN SECTION 13, (II) LOSS OR DAMAGE TO ANY SYSTEMS, RECORDS OR DATA, (III) DIRECT DAMAGES FOR BREACH OF WARRANTY (IN RESPECT OF WHICH ANY LIABILITY SHALL BE LIMITED TO RE-PERFORMANCE OR REFUND AS SPECIFIED IN SECTION 11), AND/OR (IV) INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, PUNITIVE, RELIANCE, OR COVER DAMAGES (INCLUDING WITHOUT LIMITATION FOR LOST PROFITS, LOST SAVINGS AND DAMAGE TO ANY DATA OR SYSTEMS); EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF A LIMITED REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE. YOU ARE SOLELY RESPONSIBLE AND LIABLE FOR VERIFYING THE ACCURACY AND ADEQUACY OF ANY OUTPUT FROM THE SOFTWARE, AND FOR ANY RELIANCE THEREON.


17. VERIFICATION. Licensor shall have the right to have on-site audits periodically conducted of your use of the Software. These audits are for license verification purposes only, will generally be conducted during regular business hours, and Licensor will use its reasonable efforts not to interfere unduly with your regular business activities. Licensor may also require you to accurately complete a self-audit questionnaire in a form Licensor may have provided. If an audit reveals unauthorized use, you must promptly purchase sufficient licenses and Authorized Scope to permit all usage disclosed. If material unlicensed use is found (i.e., license shortage of 5% or more), you also shall reimburse Licensor for all costs incurred in connection with the verification, including without limitation reasonable attorneys’ fees.

18. LEGAL COMPLIANCE; RESTRICTED RIGHTS. The Software is provided solely for internal research and solely for lawful purposes and use. You shall be solely responsible for, and agree to comply with, all applicable laws, statutes, ordinances, and other governmental authority, however designated. Without limiting the foregoing, this SPLA is expressly made subject to any United States government laws, regulations, orders or other restrictions regarding export from the United States and re-export from other jurisdictions of equipment, computer hardware, software, technical data and information or derivatives of such equipment, hardware, software or technical data and information. You agree to comply with all applicable export and re-export control laws and regulations in regard to products (including computer hardware, software, deliverables, technical data, source code, or any other technology, equipment, and/or derivatives of such hardware, software, deliverables, technical data, source code, equipment, or any other technology) received from Licensor. You further certify that you will not, directly or indirectly, without obtaining prior authorization from the competent government authorities as required by those laws and regulations: (1) sell, export, re-export, transfer, divert, or disclose technical data or dispose of any product or technology received from Licensor to any prohibited person, entity, or destination; or (2) use the product or technology for any use prohibited by the laws or regulations of the United States. You will reasonably cooperate with Licensor and will provide to Licensor promptly upon request any certificates or documents as are reasonably requested to obtain approvals, consents, licenses and/or permits required for any payment or any export or import of products or services under this SPLA, at Licensor’s expense. Your breach of this provision shall constitute cause for immediate termination of this SPLA. You agree to indemnify and hold harmless Licensor, its affiliates, and their respective officers, directors, employees and agents for your noncompliance with this Section. Products acquired for use within or for any United States federal agency are provided with “LIMITED RIGHTS” and “RESTRICTED RIGHTS” as defined in DFARS 252.227-7013 and FAR 52.227-19.

19. GOVERNING LAW; SEVERABILITY. This SPLA shall be governed in all respects by the laws of the State of California, USA, without regard to its conflicts of law rules or principles. Any dispute arising out of or related to this SPLA shall be
resolved only in the state or federal courts having subject matter jurisdiction in California. This Agreement shall not be
to the exclusive jurisdiction and venue of such courts. If any provision of this SPLA is held to be illegal or unenforceable for
any reason, then such provision shall be deemed to be restated so as to be enforceable to the maximum extent permissible
under law; the remainder of this SPLA shall remain in full force and effect.

20. SOFTWARE MAINTENANCE AND SUPPORT. Licensor offers certain software maintenance and technical support service
programs documented in Licensor’s then-current Support policies (“Support”). Subscription to Support shall be governed
by this SPLA and by the terms and conditions set forth in such policies. Licensor shall have no obligation to provide
Support if (a) the Software is not used in accordance with the Documentation or Authorized Scope; (b) the Software was
modified by you; (c) you have not implemented all upgrades that would otherwise correct the problem; or (d) the problem
is caused by your misuse, negligence or other cause within your control. Licensor may change its Support policies and
prices at any time. Licensor reserves the right to discontinue Support services for any Software where Licensor generally
discontinues such services to all Licensees of such Software, in which case such discontinuation shall not automatically
terminate this SPLA and the License. If you terminate Support and then re-enroll, Licensor may charge you a reinstatement
fee.

21. GENERAL. This SPLA, including any Orders, Support policies, and associated Licensor invoices (all of which are
incorporated herein), are collectively the parties’ complete agreement regarding its subject matter, superseding any prior
oral or written communications, representations or agreements. In the event that any prior oral or written communication is
in direct conflict with the terms of this SPLA, this SPLA shall control. You understand and agree that, to the extent Licensor
permits you to use a non-Licensor purchase order or other form to order Software and/or Support, Licensor does so solely
for your convenience. Any terms in any such forms that purport to vary or are in addition to or inconsistent with any terms
in this SPLA or in the applicable Order shall be deemed to be void and of no effect. Amendments or changes to this SPLA
must be in mutually executed writings to be effective. Sections 1, 4, 5, and 8 through 21, inclusive, shall survive the
termination or expiration of this SPLA. The parties are independent contractors for all purposes under this SPLA. Neither
party shall be liable for any delay or failure due to force majeure and other causes beyond its reasonable control; provided
that the foregoing shall not apply to any of your payment obligations. Any notices under this SPLA to Licensor must be
personally delivered or sent by certified or registered mail, return receipt requested, or by nationally recognized overnight
express courier, to the address specified herein or such other address as Licensor may specify in writing. Such notices will
be effective upon receipt, which may be shown by confirmation of delivery. All such notices shall be sent to the attention
of General Counsel of Life Technologies Corporation (unless otherwise specified by Licensor). You may not assign or
otherwise transfer this SPLA or any License without Licensor’s prior written consent. This SPLA shall be binding upon and
inure to the benefit of the parties’ successors and permitted assigns. You agree, at Licensor’s request and reasonable
expense, to provide reasonable assistance and cooperation to Licensor and its designees, and to give testimony and execute
documents and to take such further acts reasonably requested by the other to acquire, transfer, maintain, perfect, and
enforce Licensor’s intellectual property rights as described in this SPLA. To the extent you fail to do so, you appoint
Licensor’s or its affiliates’ officers as your attorney in fact to execute documents on your (and your personnel’s), successors’
and assigns’ behalf for this limited purpose.